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The battle itself is worth it—regardless of outcome.
The fact that we fight at all speaks more
than the result of any particular conflict.
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Getting Started
We design and develop a number of exciting projects that consist of vector shapes,
bitmap images, text, and code to help you learn the basics of interactive media
creation with Adobe Animate CC—along with other design and project management skills that you will need for a creative career in interactive media. Adobe
Animate CC (formerly known as Adobe Flash Professional CC) is a powerful program for building a wide assortment of animated and interactive project types with
sophisticated transitions, effects, and interactive elements. You can use Animate CC
to export projects to an ever-growing array of platforms and targets, including web
browsers, desktop computers, and mobile devices, through a variety of native application and web technologies.

About this book and video
Learn Adobe Animate CC for Multiplatform Animations was created by a team of expert
instructors, writers, and editors with years of experience in helping beginning learners get their start with the cool creative tools from Adobe Systems. Our aim is not
only to teach you the basics of the art of interactive media with A
 nimate CC but to
give you an introduction to the associated skills (like design principles and project
management) that you’ll need for your first job.
We’ve built the training around the objectives for the Adobe Certified Associate
(ACA) exam in Multiplatform Animations Using Adobe Animate CC, and if you
master the topics covered in this book and video series you’ll be in good shape to
take the exam. But even if certification isn’t your goal, you’ll still find this training
will give you an excellent foundation for your future work in video. To that end,
we’ve structured the material in the order that makes most sense for beginning
learners (as determined by experienced classroom teachers), rather than following
the more arbitrary grouping of topics in the ACA Objectives.
To aid you in your quest, we’ve created a unique learning system that uses video
and text in partnership. You’ll experience this partnership in action in the Web
Edition, which lives on your Account page at peachpit.com. The Web Edition contains 10 hours of video—the heart of the training—embedded in an online eBook
that supports the video training and provides background material. The eBook
material is also available separately for offline reading as a printed book or an eBook
in a variety of formats. The Web Edition also includes about a hundred interactive
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review questions you can use to evaluate your progress. Purchase of the book in any
format entitles you to free access to the Web Edition (instructions for accessing it
follow later in this section).
Most chapters provide step-by-step instructions for creating a specific project or
learning a specific technique. Other chapters acquaint you with other skills and
concepts that you’ll come to depend on as you use the software in your everyday
work. Many chapters include several optional tasks that let you further explore the
features you’ve already learned.
Each chapter opens with two lists of objectives. One list lays out the learning
objectives—the specific tasks you’ll learn in the chapter. The second list shows the
ACA exam objectives that are covered in the chapter. A table at the end of the book
guides you to coverage of all of the exam objectives in the book or video.

Conventions used in this book
This book uses several elements styled in ways to help you as you work through
the projects.
Text that you should enter appears in bold, such as:
In the Link field in the Property inspector, type http://www.adobe.com/
animate.
Terms that are defined in the Glossary appear in bold and in color, such as:
The web font that’s used in the header of the page is just what the client is
looking for. That’s a great thing.

Video 5.1 Project
Overview

Links to videos that cover the topics in depth appear in the margins.
The ACA objectives covered in the chapters are called out in the margins beside the



ACA Objective 2.1

sections that address them.
Notes give additional information about a topic. The information they contain is
not essential to accomplishing a task but provides a more in-depth understanding
of the topic.
NOTE

Notice the effect of the vanishing point, which is used to provide perspective to the artwork as it’s moved through the simulated 3D environment.
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ix

OPERATING SYSTEM DIFFERENCES
In most cases, Animate CC works the same in both Windows and macOS. Minor
differences exist between the two versions, mostly due to platform-specific issues.
Most of these are simply differences in keyboard shortcuts, how dialog boxes are
displayed, and how buttons are named. In most cases, screenshots were made in
the macOS version of Animate CC and may appear somewhat differently from your
own screen.
Where specific commands differ, they are noted within the text. Windows commands are listed first, followed by the macOS equivalent, such as Ctrl+C/Cmd+C.
In general, the Windows Ctrl key is equivalent to the Command (or Cmd) key
in macOS and the Windows Alt key is equivalent to the Option (or Opt) key in
macOS.
As lessons proceed, instructions may be truncated or shortened to save space, with
the assumption that you picked up the essential concepts earlier in the lesson.
For example, at the beginning of a lesson you may be instructed to “press Ctrl+C/
Cmd+C.” Later, you may be told to “copy” text or a code element. These should be
considered identical instructions.
If you find you have difficulties in any particular task, review earlier steps or exercises in that lesson. In some cases if an exercise is based on concepts covered earlier,
you will be referred back to the specific lesson.

Installing the software
Before you begin using Learn Adobe Animate CC for Multiplatform Animations, make
sure that your system is set up correctly and that you’ve installed the proper software and hardware. This material is based on the original 2018 release of Adobe
Animate CC and is designed to cover the objectives of the Adobe Certified Associate
Exam for that version of the software.
The Adobe Animate CC software is not included with this book; it is available
only with an Adobe Creative Cloud membership, which you must purchase, or
it must be supplied by your school or other organization. In addition to Adobe
Animate CC, some lessons in this book have steps that can be performed with
Adobe Media Encoder and other Adobe applications. You must install these applications from Adobe Creative Cloud onto your computer. Follow the instructions
provided at helpx.adobe.com/creative-cloud/help/download-install-app.html.
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ADOBE CREATIVE CLOUD DESKTOP APP
In addition to Adobe Animate CC, this training requires the Adobe Creative Cloud
desktop application, which provides a central location for managing the dozens of
apps and services that are included in a Creative Cloud membership. You can use
the Creative Cloud desktop application to sync and share files, manage fonts, access
libraries of stock photography and design assets, and showcase and discover creative work in the design community.
The Creative Cloud desktop application is installed automatically when you download your first Creative Cloud product. If you have Adobe Application Manager
installed, it auto-updates to the Creative Cloud desktop application.
If the Creative Cloud desktop application is not installed on your computer, you
can download it from the Download Creative Cloud page on the Adobe website
(creative.adobe.com/products/creative-cloud) or the Adobe Creative Cloud desktop
apps page (adobe.com/creativecloud/catalog/desktop.html). If you are using software on classroom machines, be sure to check with your instructor before making
any changes to the installed software or system configuration.

CHECKING FOR UPDATES
Adobe periodically provides updates to software. You can easily obtain these
updates through the Creative Cloud. If these updates include new features that
affect the content of this training or the objectives of the ACA exam in any way,
we will post updated material to peachpit.com.

Accessing the free Web
Edition and lesson files
Your purchase of this book in any format includes access to the corresponding Web
Edition hosted on peachpit.com. The Web Edition contains the complete text of
the book augmented with hours of video and interactive quizzes.
If you purchased an eBook from peachpit.com or adobepress.com, the Web Edition
will automatically appear the Digital Purchases tab on your Account page. Click the
Launch link to access the product.
If you purchased an eBook from a different vendor or you bought a print book, you
must register your purchase on peachpit.com:
1 Go to www.peachpit.com/register.
2 Sign in or create a new account.

Getting Started
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TIP

For a video walkthrough of the
registration process,
see www.peachpit.com/
LearnACAanimate.

3 Enter the ISBN: 9780134892665.
4 Answer the questions as proof of purchase.
5 The Web Edition will appear under the Digital Purchases tab on your Account
page. Click the Launch link to access the product.
To work through the projects in this product, you will first need to download the
lesson files from peachpit.com. You can download the files for individual lessons or
download them all in a single file.
The Lesson Files can be accessed through the Registered Products tab on your
Account page. Click the Access Bonus Content link below the title of your product
to proceed to the download page. Click the lesson file links to download them to
your computer.

Project fonts
All fonts used in these projects are either part of standard system installs; can be
found on the web for free or downloaded from Typekit, an Adobe service that is
included with your Creative Cloud membership; or can be accessed through Google
Web Fonts as a service tied to Animate CC.

Additional resources
Learn Adobe Animate CC for Multiplatform Animations is not meant to replace documentation that comes with the program or to be a comprehensive reference for
every feature. For comprehensive information about program features and tutorials,
refer to these resources:
Adobe Animate CC Learn & Support: helpx.adobe.com/animate.html is where
you can find and browse Help and Support content on Adobe.com. Adobe A
 nimate
Help and Adobe Animate Support Center are accessible from the Help menu in
Animate CC. Help is also available as a printable PDF document. Download the
document at helpx.adobe.com/pdf/animate_reference.pdf.
Adobe Forums: forums.adobe.com/community/animate lets you tap into
peer-to-peer discussions, questions, and answers on Adobe products.
Adobe Animate CC product home page: adobe.com/products/animate.html
provides information about new features and intuitive ways to create professional
layouts for print, tablets, and eBooks.
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Adobe Exchange: adobeexchange.com is a central resource for finding tools,
services, extensions, code samples, and more to supplement and extend your
Adobe products.
Resources for educators: adobe.com/education and edex.adobe.com offer a treasure trove of information for instructors who teach classes on Adobe software at
all levels.

Adobe certification
The Adobe training and certification programs are designed to help designers and
other creative professionals improve and promote their product-proficiency skills.
The Adobe Certified Associate (ACA) is an industry-recognized credential that
demonstrates proficiency in Adobe digital skills. Whether you’re just starting out
in your career, looking to switch jobs, or interested in preparing for success in the
job market, the Adobe Certified Associate program is for you! For more information
visit edex.adobe.com/aca.

Resetting the preferences to
their default settings
Animate CC lets you determine how the program looks and behaves (like tool settings and the default unit of measurement) using the extensive options in Edit >
Preferences (Windows) or Animate CC > Preferences (macOS). To ensure that the
preferences and default settings of your Adobe Animate CC program match those
used in this book, you can reset your preference settings to their defaults (the
Animate CC Help file calls this procedure “re-creating your preferences”). If you are
using software installed on computers in a classroom, don’t make any changes to
the system configuration without first checking with your instructor.
To reset your preferences to their default settings, follow these steps:
1 Quit Adobe Animate CC.
2 Hold down the Ctrl+Alt+Shift keys (Windows) or Cmd+Option+Shift keys
(macOS).
3 Continue to hold the keys and start Adobe Animate CC.
4 When the Delete Adobe Animate Preferences dialog box appears, release the
keys and click OK.
The file containing your preferences will be deleted.

Getting Started
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CHAPTER OBJECTIVES
Chapter Learning Objectives

Chapter ACA Objectives

 Meet the Animate CC workspace.

For full descriptions of the objectives,
see the table on pages 286–291.

 Understand the Stage and pasteboard.
 Discover the Properties and Tools panels.
 Explore other commonly accessed tools.
 Become familiar with the Timeline and its
key components.

DOMAIN 1.0
WORKING IN THE ANIMATION INDUSTRY

1.4
DOMAIN 2.0
PROJECT SETUP AND INTERFACE

2.2
DOMAIN 4.0
CREATE AND MODIFY VISUAL ELEMENTS

4.1

CHAPTER 1

Welcome!
Adobe Animate CC (Figure 1.1) truly is a creative powerhouse. You’re
probably most familiar with content produced with this application served
via the Adobe Flash Player web browser plug-in… but do you know
that Animate CC can also be used to produce rich, creative content that
targets HTML5 Canvas, WebGL, HD Video, SVG, iOS, Android, and
more? Animate CC is a platform-agnostic application that allows you to
design assets, animation, and interactive content of all kinds for a multitude of platforms—and all with the same tools and workflows!
Figure 1.1 Adobe
Animate CC

In this book, you’ll tackle some awesome projects that will introduce
you to the application, learn some good practices for working on projects for others, and find tips and resources you can use to learn more on
your own.

3

About the Adobe Certified
Associate Series
Let’s take just a second to explain what I’m trying to accomplish so I can be sure
we’re on the same page (pun intended!). Here’s what I (and the other authors) hope
to accomplish in these books and videos.

Have fun
This is seriously a goal for me, as I hope it is for you! When you’re having fun, you
learn more, and you’re more likely to remember what you’re learning. Having fun
also makes it easier to focus and stick with the task at hand.
Even if the projects you create as you complete the exercises in this book aren’t the
kinds of things you’d create on your own, I’ll make them as entertaining and fun as
possible. Just roll with it, and it will make the time you spend with this book more
enjoyable. Have fun, make jokes, and enjoy your new superpowers.

Learn Adobe Animate CC
This goes along with the previous item, but when you’re working on the projects
in this book, you have the freedom to explore and make these projects your own.
Of course, you’re welcome to follow along with my examples, but please feel free
to change text or styles to fit your own interests. When you’re sure you grasp the
concepts I’m talking about, I encourage you to apply them in your own way. In
some projects, you may want to even take things beyond the scope of what appears
in the book. Please do so.

Animate CC: Common Terminology


ACA Objective 1.4

You’ll need to become familiar with some technical terms that will come up often
as you work through this book and the video course it accompanies.
 Animation: A change in the properties of an object over time. In Adobe
Animate CC, animation can include not only visual changes in assets across
time (scale, position, special effects), but also sounds and more.

4

Learn Adobe Animate CC for Multiplatform Animations

 Timeline: In a general sense, a timeline is a sort of chart that plots events
through time. Animate CC has a Timeline panel that represents such
changes visually.
 Frames: The Animate CC timeline is based on frames. A frame is the smallest segment of the timeline and defines units of time for the project. For
example, in a project that is set to 24 FPS (frames per second), each second is
divided into 24 frames.
 Authortime: This is the work done in Animate CC itself apart from any
resulting project assets or publishing formats, meaning that working on the
Stage, using Animate CC tools, and manipulating the project timeline are all
things that you do during authortime and are not known to the viewer.
 Runtime: This term can refer to either of two things. When a user views a
published project outside of Animate CC, the project is now running independently of Animate itself (the authoring tool); this is runtime.
Runtime is also a technical term describing a software mechanism for executing (or “playing”) a project outside of Animate. Examples of this include the
Flash Player and AIR (Adobe Integrated Runtime) runtimes—or even a web
browser acting as a runtime for HTML5 Canvas documents.
 Publish: To export a finished project from Animate CC so it can be experienced outside the authoring tool. You can publish to a great variety of formats
and document types from Animate CC.

Animate CC vs. Flash
Professional CC
In late 2015, Adobe announced a major rebrand of its longstanding animation
software, Flash Professional CC. Adobe had long been committed to elevating
Flash Professional CC as the premier animation and interaction tool—but now as
a platform-agnostic creativity application not restricted to any single platform. To
reinforce this renewed focus, Adobe decided to rebrand Adobe Flash Professional
CC as Adobe Animate CC.
“To more accurately represent its position as the premier animation tool for the web
and beyond, Flash Professional will be renamed Adobe Animate CC, starting with
the next release in early 2016.” —Adobe

Chapter 1 Welcome!
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FLASH PLAYER 2020
Adobe has announced that they plan, in cooperation with browser vendors,
to end-of-life Flash Player in 2020. It is important to note a few things here…
this is only in regard to Flash Player and not AIR (Adobe Integrated Runtime)! AIR is a runtime and publishing mechanism for delivering applications
for desktop and mobile devices that can be developed using ActionScript
and additional Flash platform technologies. The AIR team has some very
cool stuff on the roadmap, and AIR will continue to evolve the platform.

NOTE

One very important
thing to remember is
that Flash Player did
pave the way for all the
goodies we have in the
native browser today.
We have Flash Player
to thank for advances
in dynamic content,
animation, audio and
video playback, the
browser-based canvas element, native
3D with WebGL, and
much more.

Adobe Flash Professional CC, as Adobe Animate CC, is now poised to regain its
proper place aside such giants as Adobe Illustrator CC and Adobe Photoshop CC as
a top-tier application in the Adobe Creative Cloud portfolio. A new beginning with
a great legacy behind it!

Preparation for ACA exam
This book, together with the video course it accompanies, covers every objective
for the Adobe Certified Associate (ACA) exam, but I won’t discuss them in order
or make a big point of it. The authors of the books and videos in the Adobe Press
Learn ACA series are teachers and trainers, and we’ve been doing this for a long
time. We’ll cover the concepts in the order that makes the most sense for learning and retaining the information best. You’ll read everything you need to pass
the exam and qualify for an entry-level job—but don’t focus on that now. Instead,
focus on having a blast learning Adobe Animate CC!

Developing your creative, communication,
and cooperative skills
Aside from the actual hands-on work of learning Animate CC, this book explores
the skills you need to become a more creative and cooperative person. These skills
are critical for success—every employer, no matter what the industry, values creative people who can work and communicate well. This book describes the basics of
creativity, how to design for (and work with) others, and project management.

6
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A quick note on creativity
Animate CC is, by any definition of the term, creative software. You may have
heard that creativity is something you’re born with—and that some people have
it and some don’t. Not true! Creativity may come more naturally to some than to
others, but all of us can become more creative people. It simply takes practice like
anything else. The only way to get better at creativity is to practice, experiment,
explore, and fail!
As Edwin Land said, “An essential aspect of creativity is not being afraid to fail.”
Failure is a huge part of creativity. It’s a part of the process. So celebrate and enjoy
your failures. Art is a very experimental activity. Even the best artists can make
junk. The difference between them and the rest of us is that they learn to become
comfortable with failure and recognize that it’s part of the creative process. Everyone has a thousand crummy ideas in them. A creative person is just someone who’s
used more of them up than the rest of us!
At the end of this book, you’ll explore ways to build your creativity, the same way
you build your muscles. So don’t worry if you feel like you aren’t a very strong
designer. You just need to spend some time in the creative gym!

Getting Acquainted
with Animate CC
One of the great things about Animate CC is how versatile its interface is. It’s flexible enough to adapt to the workflow and content the user encounters in any
given project, which adds to the variety of project types that users can create with
this program.
For example, some people use Animate CC only to create assets for a project, such
as spritesheets for a game or a packaged SWC library for integration with a larger
application. Others take advantage of the rich animation features core to the
Animate CC experience. Still others develop interactive web content or even full
iOS and Android apps via Adobe AIR. The creative possibilities with this application
are limitless!

Chapter 1 Welcome!
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Video 1.1 The
Animate CC
Workspace

The Animate CC workspace
The Animate interface (Figure 1.2) consists of a broad series of panels, tabbed windows, and specialized dialog boxes that provide the functionality you’ll need to
create interactive media applications, rich animations, and engaging mobile apps.
Viewing all of these options at once would fill the screen several times over. This
is why it is important to learn how to manage the workspace to show only those
panels that apply to the current task.

Figure 1.2 The
Animate CC interface

The Properties panel
Video 1.2 The
Properties and
Tools Panels

Multimedia elements in Animate CC have properties that you can freely adjust and
animate, depending on your needs. These properties can refer to position, color,
transparency, publish settings, and more.
Use the Properties panel to modify the properties of your selected object. It’s a
smart panel, so the options presented will change to reflect the element type you
have currently selected.
Figure 1.3 shows the content of the Properties panel with the document itself
selected. Because the Properties panel adapts to reveal the properties of any given
element, you won’t always see so many options available for modification.
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A

B

C
D

Figure 1.4 The Tools panel
A 
(left to right; tools marked with an asterisk * are hidden under the
preceding tool on the list) Selection, Subselection, Free Transform,
Gradient Transform*, 3D Rotation, 3D Translation*, Lasso, Polygon*,
and Magic Wand

Figure 1.3 The Properties panel

B (left to right) Pen, Anchor Point tools*, Text, Line, Rectangle, Rectangle
Primitive*, Oval, Oval Primitive*, Polystar, Pencil, Paint Brush, and Brush
C (left to right) Bone, Bind*, Paint Bucket, Ink Bottle, Eyedropper, Eraser,
Width, Camera, Hand, Rotation*, and Zoom
D 
(left to right) Stroke Color, Fill Color, Black and White, and Swap Colors

The Tools panel
The Tools panel (Figure 1.4) provides a variety of tools for creating and manipulating graphics and images within a project.

TOOLS PANEL LAYOUT
The Tools panel will appear by default as a one-column strip along the righthand side of the interface. In the figure presented here, we are displaying
the Tools panel in a different way—for the purpose of illustration—but the
tools are still the same.

The panel is divided by horizontal rules into subsections that group the tools
roughly by function. Options for any selected tool will vary.
Notice the tiny triangles on the bottom-right corner of some of the icons. These
triangles indicate that clicking the tool will bring up an additional tool selection.
This lets you access more tools that are grouped within the visible Tools panel and
switch easily between them.

Chapter 1 Welcome!

9

For instance, all the 3D tools are grouped together, but you will only ever see either
the 3D Translation or 3D Rotation tool within the panel at one time—never both,
since they are grouped.

Commonly accessed tools
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I’ll describe most of the tools in Animate CC as you come across them in working
through the various projects this book covers. A few tools are universal in terms of
when you would access them, so I’ll briefly describe them now.
 Hand tool

: Use this tool to pan around the Stage. Just select the Hand

tool and then drag on the Stage to pan around.
 Rotation tool

: Allows you to rotate the Stage if you’re using a tablet or

similar device, giving you a more natural angle at which to create assets. To
use this tool after selecting it, click anywhere on the Stage to set a pin, and
then drag to rotate to your desired viewing angle.
 Time Scrub tool

: This is a new tool in Animate CC. It allows you to easily

scrub along the timeline by dragging this tool across the Stage itself.
 Zoom tool

: As you may surmise from its name, the Zoom tool allows you

to quickly zoom in and out of the Stage. Select the tool and then click either
the icon marked with a + (plus sign) to zoom in or the icon with a – (minus
sign) to zoom out. With either of these selected, clicking the Stage or dragging
a selection rectangle with the tool will perform the requested zoom.
 Stroke Color and Fill Color

: When dealing with shapes and text,

you can define stroke and fill colors separately. Clicking either swatch here
will summon a color picker that lets you redefine the selected color or even
generate a new, specific color choice.
 Black and White

: Clicking this icon once replaces the currently defined

fill and stroke colors for a white fill and black stroke.
 Swap Colors

: Clicking this icon swaps the Fill and Stroke colors. Click

again to reverse.
 Options area: This is the area below the color tools that changes based on the
currently selected tool. Notice when the Zoom tool is selected, for instance,
how the + and – options then appear. Keep a close eye on this area as you
work through the projects with various tools selected.
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The Timeline
The Timeline panel (Figure 1.5) provides a frame-based animation and organizational structure for the interactive media authoring environment. There are a num-

Video 1.3 The
Project Timeline

ber of concepts to take note of here: layers, frames, seconds, and keyframes.
Frames

Seconds

Keyframes
Figure 1.5
The Timeline panel

Layers

Playhead

 Layers: Much like in other programs such as Adobe Photoshop or Adobe Illustrator, layers in Animate CC are an organizational construct that allows you
to stack content vertically on the Stage. Content in the uppermost layers will
obscure content it overlaps in layers below.
 Frames: Since animation in Animate CC is measured in frames per second
(fps), you can imagine that frames themselves play a big role in working
with the timeline. Frames are added to the timeline within the various layers
and determine how long the animation sequence will play, based on the
project FPS.
 Seconds: Animate CC now displays seconds markers alongside frame numbers
atop the timeline. These are placed at various frames in light of the selected
frames-per-second (FPS) setting of the document. These markers make it very
easy to see exactly what time you are at when viewing specific frames.
 Keyframes: These are special frames that contain information about a change
in the properties of the object within that layer.
 Playhead: This indicates the current frame. You can move the playhead across
frames by dragging it around. The Time Scrub tool also moves the playhead
as you scrub across the Stage.

Chapter 1 Welcome!
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ONE ANIMATED OBJECT PER LAYER
When animating content, pay close attention to be sure that each object to
be animated is on its own unique layer.

As we will see later in this book, an instance is a representation of an object that
already exists within the project’s library. You can place assets in keyframes on the
timeline by dragging such instances from the library or by importing them to the
Stage with that particular keyframe and layer selected. These assets will become
visible to the user when the playhead of the animation reaches that frame.
Keyframes that include visual content will appear on the timeline with a small,
filled circle inside. Keyframes with no content, or blank keyframes, appear similarly
but the small circle is unfilled.

Major Interface Features
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It’s a good idea, before delving into any project, to familiarize yourself with the
various panels and other interface elements within Animate CC. Although many
panels will not be needed at all times, some areas of the interface are so important that no matter what sort of project you are working with, you need to have
them visible.

Managing panels
Video 1.4
Managing Panels

All individual panels or groups of panels can be minimized or maximized to make
the best use of your screen area. You do this using the small double-arrow icon
located in the top-right corner of the panel or panel group (Figure 1.6).
When a panel is collapsed, the arrows will point left; clicking the arrows will
expand the panel or panel group to show the full interface.
When a panel or panel group is open, clicking the arrows will collapse the panel or
panel group to icon mode.
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Collapse to
Icons button
Figure 1.6
Collapsing a panel

Using workspace presets
With the number of creative options available for any given project, it makes sense
that certain workspace configurations and panel sets might be better suited to

Video 1.5 Using
Workspace Presets

certain tasks. For instance, if you’re working on an animation that is not going to
include any interactivity or code whatsoever, it wouldn’t make sense to clutter the
workspace with panels for writing code or managing code snippets.
Animate CC ships with a number of prebuilt workspaces optimized for certain tasks
(Figure 1.7):
 Animator: This workspace positions the Timeline and
Stage at dead center and includes quick access to scenes
and document properties.
 Classic: Miss the good ol’ days when Flash animation on
the web was king? This workspace preset replicates the
panel layout of Macromedia Flash 4…or thereabouts.
 Debug: This workspace is extremely important for codeheavy ActionScript projects. This preset reveals the

Debug Console and V
 ariables panel, allowing simple
debugging for complex interactive content.

Figure 1.7 Workspace presets

Chapter 1 Welcome!

13

 Designer: This workspace is similar to the Animator preset, but with a greater
emphasis on colors and tools.
 Developer: Quick access to the Components panel and a de-emphasis on the
Tools panel are the hallmarks of this preset. It also makes the Compiler Errors
and Output panels readily accessible.
 Essentials: This is the default workspace preset for Animate CC and aims to
be balanced and uncluttered.
 Small Screen: This workspace provides a good example of how the various
panels and panel groups can be collapsed. It’s a good choice for screens with
very little space.

Creating a custom workspace
Sometimes the built-in workspace presets aren’t enough. For instance, maybe you
have a small-screen laptop or are working across multiple monitors, or maybe
you have a specific task that you do frequently that requires only a few panels to
be visible.
You can create a custom workspace by opening and arranging the panels to your
liking and saving the layout as a custom workspace.
1 To begin, modify the set of panels and panel groups you’d like to include in
your custom workspace.
2 Choose New Workspace from the Workspace menu (sometimes called the
“Workspace chooser”).
3 Enter a unique name for the new workspace and click OK (Figure 1.8).
Figure 1.8 Naming a
custom workspace

Now you’ll be able to easily recall this particular workspace setup through the
Workspace menu.
When customizing your workspace or simply working with panels, you should take
note of a few things. The panels in the Animate CC interface have tabs that can be
used to assign the panel to a group or quickly maximize and minimize the contents
of the panel without collapsing the entire group.

14
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Here are options for organizing and accessing custom workspaces:
 Drag a tab into a group to make that panel part of the group. If you drag the
panel tab next to another tab, it will create a tab group.
 Drag the panel above or below another tab or tab group to create an accordion arrangement. Double-click a tab to collapse the contents of that panel
vertically. Double-click again to expand the panel.
 You can also choose to lock any panel through its options menu. This prevents the panel from being moved around by mistake.

The Stage and pasteboard
The Stage (Figure 1.9) is the main visual layout area for the project. Objects that
appear on the Stage at any given frame will be visible when someone runs the project outside of Animate CC, whether it is an HTML5 Canvas, WebGL, Adobe AIR, or
Flash Player project.
Figure 1.9 The Stage
and pasteboard

Stage

Pasteboard

The Stage has a number of important aspects you should be aware of. Let’s start
with the Stage resolution in width and height. The default resolution is 550px wide
by 400px in height. Getting the Stage size right—or at least giving it an appropriate
aspect ratio—is crucial when beginning a new project. The background color determines the default Stage color when there are no other elements obscuring it. The
background color of the Stage is always a solid color.

NOTE

You can always create
a large, rectangular
shape containing a
gradient or pattern or
even use an imported
image if your background needs to be
complex.

Chapter 1 Welcome!
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Video 1.6
Common Keyboard
Shortcuts

The pasteboard consists of the space surrounding the Stage. You can use the pasteboard as a scratch area or a drawing surface, or even include visual elements off the
Stage that will animate into the Stage at a later time. Anything on the pasteboard
will still be included in the compiled files—and will add to the overall file size—so
be careful. It is a versatile feature that you should definitely make use of.
TIP

Many common tools and actions have keyboard shortcuts assigned to make
accessing them quicker. You can view the assigned shortcuts and even
create your own by choosing Animate CC > Keyboard Shortcuts (macOS)
or Edit > Keyboard Shortcuts (Windows).

Let’s Get Going!
Okay—that’s everything you need to know going in. You’ll complete seven separate projects in this book that cover all the basics of using Animate CC for creating
content targeting Flash Player, HTML5, Adobe AIR, iOS, Android, and more. The
creative possibilities are truly endless—so let’s get started!
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Chapter ACA Objectives

 Create and prepare documents.

For full descriptions of the objectives,
see the table on pages 286–291.

 Create shape assets.
 Manage the timeline.
 Animate objects with keyframes and
tweening.

DOMAIN 1.0
WORKING IN THE ANIMATION INDUSTRY

1.4

 Emulate natural movement through easing.

DOMAIN 2.0
PROJECT SETUP AND INTERFACE

 Publish a project.

2.1, 2.3
DOMAIN 3.0
ORGANIZATION OF DOCUMENTS

3.1, 3.2
DOMAIN 4.0
CREATE AND MODIFY VISUAL ELEMENTS

4.1, 4.3, 4.4, 4.7
DOMAIN 5.0
PUBLISHING DIGITAL MEDIA

5.2

CHAPTER 2

Design a Vector
Animation
Adobe Animate CC can be used for a wide range of project types, but at
its core it remains a highly capable vector animation tool. This initial project is designed to ease you into the Animate CC user interface and its
tools in order to complete a series of tasks focused on vector animation.
When you’re finished with this project, you will have created a short animation of a ball bouncing on a floor. Although this may not be the most
exciting of projects, it will introduce you to many of Animate CC’s vector
drawing tools along with animation techniques you can use across just
about every other project in this book.
One thing that Animate CC is often used for in educational settings is to
create simulations for classes or reference materials. Think of this project
as the simulation of a bouncing ball (because that’s basically what it is).
This project will incorporate many of the fundamental concepts you’ll
encounter when working with animated vector content. This includes
creating and preparing documents; creating shape assets; managing the
timeline; animating through frames, keyframes, and tweening; making
animation more natural and pleasant; and publishing your project.
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Video 2.1 Project
Overview

Keeping this project small in scope will leave us room to go over some of the other
tools you might find useful when creating and working with vector shapes in Animate CC (Figure 2.1). These include the Pen, Brush, Pencil, and various selection
and management tools. I’ll discuss these tools as they become useful in the project.

Figure 2.1 Vector
 nimation in Animate CC
a

Creating the Project Document
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Although any Animate document will be in the form of a common FLA file, the
capabilities and options available to you when working on a project will depend on
the specific target platform.
Whereas Animate CC used to be used solely for the creation of content that will
run inside the browser-based Flash Player runtime, Adobe has been positioning
the application in recent years to allow for an infinite number of target platforms.
Some of the platform targets that ship natively with Animate CC are HTML5

Canvas, WebGL, ActionScript 3.0 (targeting Flash Player or Adobe AIR runtimes),
plus an array of custom platforms.
Whichever document type you choose to create, there are a number of other publish options that are platform agnostic. These can include SVG, HD Video, bitmap

images, spritesheets, and more.
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The Animate CC document file
Before even concerning yourself with the specific properties of a document, you
need to choose your eventual target platform for the current project. You have a
number of great choices with Animate CC, and they all share a common document
format: the FLA file.
Animate CC creates an FLA file whenever you open a new document. It acts as a
package to hold the internal assets and to keep your project organized. A simple
project can consist of a single FLA file that holds all necessary artwork, sound, and
code. This is one of the major strengths of Animate CC: the tight integration of
design and development.
Animate CC uses a variety of file types in the process of creating and displaying
interactive media applications. Some of the file types are specific to the Animate
CC environment; others are more generic file types, including those used for
images and audio.

NOTE

An FLA is a compressed file type,
meaning that all the
files and folders it contains have been written
to a single file. An
XFL is uncompressed
and exists as a series
of exposed files and
directories.

The ActionScript 3.0 document
Animate CC has deep roots in ActionScript and the Adobe Flash runtimes: Flash
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Player and Adobe AIR. This should come as no surprise. For the majority of its
lifetime, ActionScript was the only platform supported by Animate CC. As a result,
choosing any of the AS3-based document types allows for the fullest set of creative
tooling and the use of a deeply mature programming language, ActionScript 3.0.
For this project, you will create a new ActionScript 3.0 document. You’ll explore
other document types throughout this book, but since the idea with this project
is to start off simple and explore core, traditional functionality, it makes sense to
employ the document type that Animate CC is most comfortable with.

FLASH PLAYER 2020

NOTE

Any Animate document,
no matter what the target platform, will take
the form of an Animate
Document file with the
extension of .fla (or .xfl,
if that is your preferred
format).

Even though Flash Player as a web browser plugin will be going away by the
year 2020, it is important to note that ActionScript, Adobe AIR, and even the
SWF file format will not be going anywhere!

Chapter 2 Design a Vector Animation
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Setting document type and properties
Video 2.2 Creating
a New ActionScript
3.0 Document

The first thing to do when creating a new Animate CC project is to make some
decisions about document type and properties. The main properties of an Animate
document include the stage size, frame rate, background color, guides, and ruler
units. These properties are usually set when the document is first created, but sometimes it’s necessary to adjust them afterward.
In this exercise, you’ll create your first Animate document and explore some basic
properties settings.
1 Start Animate CC. If you’re opening the application for the first time, you
should see the Welcome Screen (Figure 2.2). You can disable this feature if
you like, but it provides a useful display of all the choices you can make when
starting off a new project, or even continuing a project you’ve already been
working on.

Figure 2.2 The Welcome
Screen

2 In the center column, under the Create New heading, click ActionScript 3.0,
which is the third option from the top.
You will immediately be taken to a new Animate document that you can
modify however you like (Figure 2.3).
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Figure 2.3 A new
Animate document


ALTERNATIVE DOCUMENT CREATION
Before continuing, you may want to try another way of creating a new
 ocument—directly from the Animate CC workspace when the Welcome
d
Screen isn’t open. Creating a new document this way allows you to select
some basic settings, like width and height, before Animate CC opens the
new document.
Choose File > New from the menu bar to open the New Document dialog
box, which displays an expanded list of document types. Click Cancel to
close this when finished, since you already created a new document from the
Welcome Screen.

Notice that the document properties are displayed in the Properties
panel for the document you’ve created (Figure 2.4). Here, you can
modify some document properties and then save your document as
a file.
The default width and height for a new document is 550px wide by
400px tall. This is fine for the current project, so leave these values
as they are.
The default frames per second (fps) value is set at 24. This is also
fine for now.

Figure 2.4 The Document Properties
section of the Properties panel
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3 Choose a background color for your stage. I nearly always choose black, but
you can pick whatever color you like.
Now you have a new document with some basic stage properties configured.
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4 Choose File > Save to save your document. Note that you have two options
here: FLA and XFL (Figure 2.5). An FLA file is the easiest to manage, since it’s
a neat little bundle and all you need to worry about is a single file. Stick with
FLA, type a name for your file, and then click Save.

Figure 2.5 Choosing
a file type

WHAT ARE XFL DOCUMENTS?
Recent versions of Animate CC not only allow the creation of Animate CC
authoring files in FLA format but also can save projects in XFL, a format
that’s much easier to edit outside of Animate CC or to use with a version
control system like Subversion or Git. The proper name for the file format is
Flash Uncompressed Document, shortened to XFL with the X standing for
XML (Extensible Markup Language) and the FL for Flash.
An alternative to the packaged FLA format, the XFL file format represents
an Animate CC project as an XML document alongside a set of other folders
and files. Each XFL structure has, at its heart, a file called DOMDocument.
xml. If you open this file in a text editor, you’ll see all of the information for
your document, including timeline data, code, motion paths, and so on.
Remember that the FLA file format is simply an archived version of the XFL
structures and documents. You can have a look for yourself! Just change the
filename extension to .zip and open the file in a ZIP utility. The one built into
Windows should handle this automatically, but macOS users may have to
resort to a third-party app.
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ADJUSTING DOCUMENT PROPERTIES AFTER FILE CREATION
Even with the best planning, it is sometimes necessary to make adjustments
to a project file’s document properties after it has been created. This can be
due to changes in delivery platform or performance issues.
The simplest way to do this is to choose Modify > Document to open the
Document Settings dialog box. This dialog box contains the same information that was presented when a new document was created.

Preparing the project Stage and timeline



Before moving on to creating some vector shapes and moving them around, you’ll
do a little project preparation to organize your document.
Almost always, I find it useful to have snapping enabled in my projects. Snapping

ACA Objective 2.3
Video 2.3
Preparing the
Project Stage
and Timeline

will enable the application itself to “snap” objects to x and y coordinates based on
a number of settings that you can select according to taste. It can make positioning
objects in a precise way much easier. Animate CC offers a number
of snapping options, and I enable them all. Whether you benefit from snapping or not will depend on how precisely you like
things to be positioned on the Stage.
To enable or disable various snapping options, choose View >
Snapping > Edit Snapping from the application menu (Figure 2.6).
This will open the Edit Snapping dialog box, where you can select
the snapping options for your project. Note that you can also
toggle these options on and off directly from the View menu.
TIP

You can also enable both rulers and the grid from the same View
menu. Experiment with all these options to see what works best for
your work style.

Let’s have a look at the timeline (Figure 2.7). You’ll notice that
within the timeline itself, a numbered system of frames extends
horizontally along the timeline for the length of the animation,
and a series of layers runs vertically down the timeline. Another

Figure 2.6 Select Snapping options here.

series of numbers at the top of the timeline counts off elapsed
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time in seconds calculated from the document FPS value. Note that in a new document such as you have here, you have one layer (called Layer_1) and a single frame
(at the Frame 1 position). Initially, every new document includes only a single
frame on the timeline.
Figure 2.7 The Animate
CC timeline

1 To begin, double-click the “Layer_1” text to make its name editable, and type
in Floor. You’ll use this layer to hold the vectors drawn to represent the solid
floor of the bouncing ball simulation.
2 Next, click the New Layer (

) button at the bottom of the timeline—it looks

like a sheet of paper.
This creates a new layer in the timeline, again with a default name.
3 Double-click the layer name and type Circle to rename it. This is the layer
within which you’ll draw out your bouncing ball vector shape.

Controlling layers and folders
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Besides the ability to create new layers, you have a number of other options at
the bottom-left side of the timeline that you can use to manage layers and related
items (Figure 2.8):
 Click the page icon (

) to create a new layer.

 Click the folder icon (
 Click the trash can icon (

) to create folders for grouping layers.
) to delete unneeded layers.
Figure 2.8 Click these three
icons to manage layers.

Layer management icons
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